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About PDF to Flash Flipping Book Pro 

PDF to flash flipping book pro is a smart 

software developed form our already-have 

product, PDF to flash flipping book, but with 

more functions and power. Just like its name, 

we can create a more stunning flipping book 

with embedding link, movie, image, sound, 

flash, button, YOUTUBE video and area for 

printing. Besides, the function of command line 

helps to automate the conversion.  

 

 

 

 

 

 

 
 

 

Professional features: 

1.  Change the existing icon on toolbar through editing icon flash file;  

Note: This product is distributed on a "Try before-you-buy" 

basis. All features described in this documentation are 

enabled. The registered version doesn't insert a watermark in 

your generated page-flipping eBooks. 
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2.  Insert new button icon calling new action if necessary;  

3.  use about button to add your contact or some other information; 

4.  Add image to the page you imported (customize its action, like play 

audio, go to webpage, etc); 

5.  Add links (define action) to your page;  

6.  Insert FLV movie and define every detail of the movie;  

7.  Add any sound to your page;   

8.  Insert SWF flash to enrich your page;  

9.  YOUTUBE video can be added to your page ; 

10. Output project embed links, video and sounds, save it for future      

using;  

11. Support command line conversion. 

 

Basic features: 

1. Convert any PDF file（including its bookmark, links）to adobe flash 

based flip book; 

2. Support batching convert bulk PDF  files to flipping book;  

3. Import all the pages from original or just some pages based your 

needs; 

4. Define the quality and size of the book whatever you like;  

5. Set a exclusive watermark which is only belong to yourself ; 
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6. Keep the hyperlink including web link, page link and email  link    

of the original PDF flies in flipping book; 

7. Import or edit bookmark to divide the book into categories for 

easy reading; 

8. Import whole book text content to enable full-text search , useful 

for bigger page flips; 

9. Detect wide page so that It can be viewed clearly and 

comfortably; 

10. Select a built-in theme or template (classical, float, neat, spread) 

as you like;  

11. Add your own book title or book logo to the flipping book button 

bar;  

12. Show or hide home button, help button, print, download to make 

your book more flexible and powerful; 

13. Define content of help window, also the looks and feels;  

14.  Decorate eBook with your favorite color  

10.1 Define button color, search highlight color, icon color;  

10.2 Set font color, whether window font, book mark font, window font 

or search result font;  

10.3 Design background color, flash window color and page background 

color;  
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15.  Insert a sound file which will be playing as a background book 

music;  

16.  Use zoom in/zoom out unlimitedly and set zoom scale;  

17.  Share with your friends via email or upload it to social network 

like Face Book, Twitter, Digg, Google, etc; 

18.  Support auto-flip with flip-interval and play count setting ; 

19.  Enable single page or double page view mode; 

20.  Define Multilingual version books for different language users;  

21.  Add book frame bar to flip much easily ; 

22.  Set book reading from right to left for words start with left 

languages;  

23.  Design hard cover to enhance the reality of the book;  

24.  Set a password to prevent disallowed accessing; 

25.  Use GOOGLE analytics to know the number of people who have 

read your published book;  

26.  Preview the effect after setting right away;  

27.  Export and save the project if you think everything is okay; 

28.  Output the book in different formats (HTML, ZIP, EXE, Mobile 

version, burn to CD) 

28.1 HTML is a format which can make you upload your book to 

the Internet; 
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28.2 ZIP is a format which allow you share the book with your 

friends via email; 

28.3 EXE is single output format which allow book reading 

separately; 

28.4 Mobile version is for people to read ebooks on iPhone, iPad 

and Android devices; 

Burn to CD/DVD lets you send the book in the physical form to 

customers or people you want to share as a gift.  

Viewer features: 

After finishing your digital book, your viewer will be able to: 

1. Drag the corner of the page to go to previous or next page;  

2. Click the page arrow or page frame to reach the previous or next 

page; 

3. Use thumbnail button to navigate fast through a large publication; 

4. Just need a few clicks on navigation buttons to go to previous page, 

next page, first page and last page; 

5. Click help button to get a hand when needed;  

6. Use search button to find out the page to get related info; 

7. Print out the whole book or some pages only;  

8. Make the book full screen for convenient reading;  

9. Zoom in/ zoom out on pages if the page font is too small to read;  
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10.  Turn on/ off the background music  

11.  Flip with a single page or double pages;;  

12.  Share with anyone via email, Face book, Twitter, Digg, Google etc; 

13.  Download the ZIP or EXE book from website to read locally 

directly;  

14.  Enjoy this digital publication on iPad, iPhone and Android 

devices. 

Quick Start 

1. Launch the application via the desktop shortcut ; 

2. Click the "Import PDF" icon  to enter into Import PDF interface; 

3. Click icon to choose PDF file from your computer; 

4. Click icon to enter into template setting interface; 

5. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and 

then click the "Apply Change" icon ; 

6. Click "Convert to Flipping Book" icon to enter into Output 

interface; 

7. Choose Output Type from HTML, ZIP and EXE, here take 

as example; 
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8. Click to set Output Folder as "C:\flipbook", input File Name 

as "demo"; 

9. At last, click icon to output created page-flipping eBook. 

 
You can open the "flipbook" folder in "C:", there are three files in this folder: 

 

 

Open the "demo.html" file to view your created p00age-flipping book via Web 

Browser, such as Internet Explorer, Google Chrome, Firefox, etc. 
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Interfaces 

There are some main interfaces you will see while using PDF to Flash 

Flipping Book Pro as below shows: Application Options, Import PDF, 

Template Settings, Edit Pages, Language Option, Export Theme, Output, 

Batch Convert and Command Line. 

You can enter into each page to get clear instructions for every detail 

option. 

 

I. Application Options Interface 

1. Render Engine Option 

 

PDF to Flash Flipping Book Provides 3 different render engines for you to create 

higher quality page-flipping eBooks, click "Options->Application Options" to enter 

into "Render Engine" interface: 
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SWF: Much legible characters, smaller output size 

GPL Ghostscript: Higher color transfer quality 

Inner Library: Faster convert speed 

(Change option when PDF imported failed) 

 

2. Create Mobile Version Option 

(1) Pages Quality and Size 

Five types of "Pages Quality And Size" for mobile version eBooks: 

 

 

(2) Mobile Template 

The current version provides two mobile template modes for you to use: Slide and 

Single Page Flip. The later one adds page-flipping effect on the pages while viewing 

in mobiles. 

II. Import PDF Interface 

 

Panel Description: 
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1. Source PDF File:  

 Click this icon to open the PDF file you want to convert; 

 View content of added PDF file to clarify before converting. 

 

2. The Page Ranges to Import: 

 Convert all pages to page-flipping eBook; 

Convert defined range page; 

 Just preview effect on first 10 pages. 

3. Watermark 

 Add image or text watermark to flipping pages. 

Check this option first to choose default stamps or add new ones: 
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4. Page Quality 

There are five types of "Quality And Size": 

 

5. Other Options: 

 

If your PDF file contains bookmarks, check this option to use in output 

page-flipping eBook; 

If your PDF file has links, check this to enable in flipbook; 

Check this option to enable search functionality in created flipbook. 

Check this option to make landscape page in PDF file to be presented as 

two-page spread in output flipbook. 

 

At last, click  icon to enter into template setting interface. 

III. Template Settings Interface 
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PDF to Flash Flipping Book Professional provides 4 different templates in the program: 

Classical, Float, Neat and Spread. Each template contains some unique settings, the below 

instructions will show you details about the default three templates. 

 

The design setting interface contains below main parts: 

Choose Template, Tool Bars Settings, Flash Display Settings and Flash Control Settings. 

 

1. Choose Template 

 

Click icon to select templates from below interface: 

 
Download more themes from Flash-Flipping-Book now: 

http://www.flash-flipping-book.com/templates-themes/index.html . 

 

 Click this icon is to save current settings as a TXT file for later uses; 

 Click this icon is to import stored setting file at once. 
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2. Tool Bar Settings 

 
 

(1) Title Bar (only in Float template) 

 

Customize book title and logo for showing on the top of your flipbook. You are enabled to 

set the book title as HTML format text. For example: <a 

href='http://www.flash-flipping-book.com' target='_blank'>FLASH-FLIPPING-BOOK.COM</a> 

| <font color='#ff0000' size='14'>Red Color</font> 

(2) Buttons Bar 

 

 

i. Home Button 

You can add a home button  to help reader to click and go to your website directly: 

 

 

ii. About Button 

Add About button  to show the author, contact, book, company info: 
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Click "…" to enter into "About & Contact" edit interface: 

 

After clicking the About button, you will view the About window by clicking the button: 

 

iii. Full Screen Button 

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen 

Button" option:  

Then you can click icon  to view flipbook in Full Screen, click icon  or "Esc" 

button to exit from the Full Screen. 

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode, 

you can set "No" in "Full Screen without Tool Bar" (just in Classical Template): 

 

 

iv. Help Config 

 

To show tips about viewing flipbook, you can set "Show" in "Help Button" option, and you 
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can define Help Content manually by inserting "Help Content File (image or SWF)", also 

enable to define the Width and Height of the Help image or swf. If you set "Book->Retain the 

book to center->No", you can set "Show Help At First->Show" to display the Help Panel with 

the Book as below: 

 

You can also click the button  to view the same Help page in pop-up window. 

v. Print Config 

 

Choose "Yes" in "Print Enable", then click icon  to set print page range as below: 

 

You can also click "Print Watermark File->…" button to choose image or SWF file from your 

computer as watermark on printed out pages. 

 

vi. Download Setting 

  

If you want your flipbook readers to download the PDF file or the flipbook directly from your 

website, select "Yes" in "Download Enable" option, then input the Download URL directly, 
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you can use absolute path like 

"http://www.flash-flipping-book.com/flip-pdf/example/files/download/FlipPDFDemo.pdf" 

or relative path like "/files/download/FlipPDFDemo.pdf" (make sure you have uploaded the 

PDF to the same path). 

Then readers can click the icon  to download your uploaded PDF file directly. 

 

vii. Sound 

 

If you want to add background sound to your flipbook, such as a song or other audio file, set 

"Enable Sound->Enable", then click " " icon to choose "Sound File" from your computer, 

then set "Sound Loops", "-1" stands for playing the sound file all the time while viewing 

flipbook, other value (N>0) stands for the times of playing the sound file. 

 

viii. Zoom Config 

 

To Enable Zoon In functionality, choose ''Yes" in "Zoon in enable", then set "Zoom Scale", the 

value is the times between zoomed page size and the current page size. 

 

In Float template, you don't need to set Zoom Scale, you can adjust more conveniently by 

the zoom in tool like this: . You can also set "Scroll 

with mouse->Yes" to scroll zoom in page while moving mouse. 

 

ix. Search 
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Select "Show" in "Search Button" (make sure you have check "Enable Search" option in 

"Import PDF" interface), then define "Search Highlight Color", after clicking "Search" icon 

, you will see a popup box to input search words, then click Enter or "Search" button, 

you will get the below searching result: 

 

x. Share 

 

You can share via emails, or just through Facebook, Twitter, Google, etc.. 

a. Share Button 

If you want readers to share via Email, you can enable "Share" feature as below shows: 

 

When the viewers click the share button , they will enter into the Email interface with 

the link of your flipbook in the Email body. 

 

b. Social Share 

If you want your flipbook viewers to send the link to their friends or clients via Facebook, 

Twitter, Linkedin, Google, Yahoo and so on, you can add a Social Share button in your 

flipbook for readers to send out your flipbook link immediately: 

 

The readers just need to click the "Social Share" button , then the below window will pop 

up for them to choose share channel: 
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xi. Auto Flip 

To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the 

Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times 

of auto playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip 

button , the flipbooks will be flipped by staying 3 seconds per page); if you want to 

auto start and flip the eBook after opening, just set "Auto flip when start up->Yes": 

 

 

xii. Thumbnail Button 

 

Show Thumbnail Button (set "Enable") to view page thumbnails of your book, or you can 

disable it to hide the button. 

xiii. Single Page 

 

If your book contains landscape pages, or the page content is different to read for the font is too 

small, you can set "Single Page->Enable" to enable readers to click "Single Page" icon  to 

view pages one after another, then click "Double Page" icon  to back to the normal book 

reading mode. 

 

xiv. Language 

 

You can set language for showing tools or tips in your created flipbook, click "…" to enter into 
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"Language Settings" interface. You can choose two or more language to use, just check 

"Switchable" option, then users can click "Switch Language" button to choose their 

prefer language for tips (more language setting details you can view in below Language 

Setting part): 

 

 

(3) Tool Bar on Top (only in Float template) 

If you want to place the toolbar in Float templates on the top of the flash eBook, you can set 

"Tool Bar on Top" as "True": 

 

(4) Add Icons Settings 

If you want to add some other kinds of buttons which the program doesn't provide, you can click 

"Add Icons Settings->…" to enter into "Icons Settings" interface to add new icons on tool bar: 

 

You can define the link action as "Go to page", or open an online webpage, or even "Call 

Javascript function" to carry out your wanted interactive functionalities via defining Javascript 

function yourself.. After your "Apply Change", the new added icon will show in the toolbar. (More 

details about Call Javascript function will be introduced in the part of "Edit Page->Add Link".) 
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(5) Button Icons 

Define settings for the icons of the buttons: 

 

i. Icon Color  

 

ii. Icon File 

Select the Tool Bar Button to replace with your own icon.  

 

More details please view here:  

http://www.flash-flipping-book.com/support/how-to-replace-icons-on-flash-toolbar.htm 

 

3. Flash Display Settings 

 

(1) Retain the book to center 

 

If you select “No” in this option, the eBook will be shown on the right-side. This setting is for 

embedding special background image, such as advertisement or company log. 

 

(2) Pages per thickness (only in Neat template) 

To create more real life like ebook, you can set Pages per thickness, which means how many 

pages to show a distinguishable thickness. The smaller value set, the thicker your book. If the 

value is smaller than 0, or larger than the total page number of your book, it won't show any 

thickness. And on the book edge, you will see different page number tips for you to click and go 
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to that page directly: 

 

 

(3) Font 

 

Change fonts of toolbar buttons, flash windows even bookmarks or search result panel. 

(4) Initial Show (set in Float/ Spread templates) 

You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just 

select "Bookmark" or "Thumbnails" in this option: 

For Example, select "Thumbnails":  

Then you will get flipbook shown with below initial interface: 
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(5) Background Config 

i. Background Color:  

 

Define background for your flipbook with gradient color or pure color (the same color for 

"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between two colors. 

ii. Background Image (set in Classical and Spread templates): 

 

Click the icon " " to choose background image from your computer, and there are 11 kinds 

of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right, 

Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.  

iii. Background Image (set in Float template): 

 

The Float template enables you to add two background images: Outer Image and Inner 

Image. You can make Inner background image to show special information, such as 

advertisement or company logo, etc. There are also 11 kinds of "Image Position" for you to 

choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle 

Right, Bottom Left, Bottom Center and Bottom Right. 
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(6) Flash Window Color 

 
This color will be applied on all flash windows, such as the book window, "Help" window, 

"Print" window and so on. 

 

(7) Page Background Color 

 

When load pages, or if the page number of your PDF file is odd, then the page (the last page) 

will show with the "Page Background Color". 

(8) Book Proportions 

 

Please note that the values are not fixed in pixels or inches, they represent a ratio of "Page 

Width: Page Height", and the book size will be adjusted with your Explorer Window Size. 
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(9) Book Margins 

i. Book Margin (set in Classical Template): 

 

"Book Margin" refers to the distance between the book and the toolbar. 

ii. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template): 

 

(10) Page Shadow 

 

The value also takes the value of Book Proportions as reference, and the value interval of 

"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color. 

 

(11) Hide Book Frame Bar 

 

If don’t want to show the book frame bar, choose “Yes” in this option. 

 

(12) Right to Left 

If the language of your file is read from right to left (such as Arabic), then choose "Yes" in 

"Right to Left" option: 
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(13) Hard Cover 

If you want create hard cover effect (a book bound with rigid protective covers) for your 

flipbook, choose "Yes" in "Hard Cover" option: 

 
 

(14) Flipping time 

 

Sets page flipping time in seconds according to your needs. (Recommended value is 0.6) 

 

(15) Page Number 

If you don't want to count in the cover page, table of contents pages into the actual page 

numbers, you can set "Start Page Numbering (Roman)" and "Start Page Numbering (Arabic)". 

For example, the first 3 pages are Table of Content pages with Roman page numbers, and 

set Arabic page numbers from page 4, then you will get page number box like below: 
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(16) Minimize Style 

If you want to present Page-flipping eBook pages directly without showing toolbar, especially 

when you want to embed eBook into a small area in existing web pages, then you can use this 

"Minimize Style". 

 

The Minimize Style will trigger when the Width or Height of the Flash Container is less than the 

defined value. You can also always show the page-flipping eBook in Minimize Style with adding a 

parameter to your URL like this: www.yourdomain.com/index.html?alwaysMinimeStyle=true . 

 

 

4. Flash Control Settings 

 

 

(1). Security Settings 

 

If you want to protect your flash books with passwords, you can click "…" icon to enter into 

"Flash Security Config" interface: 
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Select "Security Type->Single Password", and input passwords into the box (there is no 

restriction on password format at present). You can also set "Protect Page Range" as "All 

Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4 

algorithm to protect eBook pages, the eBook content pages will show nothing without 

permission.) 

 

(2). Links 

 

If you have check "Import links" option in "Import PDF" interface, or add links in "Edit Page" 

interface, then you can define settings here, choose "Mouse over color", "Link alpha" (refers 

to the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent), 

and "Open Window->Blank/ Self". The links also can be clicked after zooming by setting 

"Enable after Zooming in->Enable". 

 

(3). Google Analytics  

 

In the HTML output format, you can add statistics by using google analytics. You can get 

more information about Google Analytics ID from http://www.google.com/analytics/ . 

 

Besides, Export Theme 

 

If you want to save the current template settings as your own style template for later uses, 

you can click "File->Export current settings as Theme" button to storing all current template 

settings, include the background images, margin values, toolbar buttons and so on. 

Then when you want to use later, just click "File->Import Themes", the theme will be added 

to the templates selecting interface. 

 

Download more themes from Flash-Flipping-Book now: 

http://www.flash-flipping-book.com/templates-themes/index.html . 
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After setting template and language, click  icon to apply the settings. 

 

IV. Edit Pages 

Use PDF to Flash Flipping Book Pro to edit imported pages directly, no matter you want to add 

link, video, sound or image file. Click "Edit Pages" button  to enter into page 

edit interface: 

 

 

1. Add Link 

Click the icon  and then draw a link box on the area you want to add link, then define 

properties in below panel: 
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You can define the link action as "Go to page", or open an online webpage, or even "Call 

Javascript function" to carry out your wanted interactive functionalities via defining Javascript 

function yourself.. For example, you can show a pop-up light box while readers clicking some 

image on page, or pop-up a questionnaire or other Web Form by clicking some text. Just make 

sure the parameter you set in "Function" can be called in from HTML page. 

 

Example: Check "Call Javascript function" as action type, then input Function as 

"testLightBox("Hello, this is a test"): 

 

 

And then make sure the Javascript wrote into the index.html page as below image shows (the 

same as you set in "Link Function"): 
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2. Add Movie 

 

Click icon  and then draw a box like below on the page you want to insert FLV movie: 

 

Then you can select and edit the movie in below panel (define video player skin color, play and 

stop movie actions, etc.): 
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3. Add Image 

Click the icon  to draw image box and then select image (.jpg, .png, .bmp), set Action 

Options (the same as Link Action Options): 

 

 

 

4. Add Sound 

Click the icon  to draw sound box and then select sound file, set other options: 

 

 

5. Add Flash 

Click icon  to insert SWF flash into your defined area of flipbook page: 
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6. Add Button 

 

Click icon  to draw an area for inserting your image or SWF button file with calling actions. 

The actions contain "Go to page", "Open a link", "Call Javascript function" and "Open Flash 

Window". The before three actions are the same with the actions in "Add Link", the "Open Flash 

Window" can help you to play SWF Flash or FLV Video in the pop-up window: 

 

 

 

7. Add You Tube Video 

Click the icon and then draw a box on the page to insert You Tube video into pages directly. 

You just need to define the video ID directly. For example the video link is: 

http://www.youtube.com/watch?v=xKA6WIqjB7c, then the video ID is " xKA6WIqjB7c".  
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8. Add Printable Area 

If you want readers can click on some area of your book to print the area directly, such as 

coupons which can be used to buy your presented goods, you can add a "Printable Area" on 

pages by clicking the icon , and then draw the area on the pages, set title and description: 

 

 

9. Copy and Paste  

If you want to add same links, images, videos, audios to different pages, you don't have to repeat 

the "Link/Image/Video/Audio added" operations once and once again, just select the link object, 

click the copy button and then go to the other page to click the paste button directly. 

 

10. Apply All 

If you want to use the same link, video, audio, image or button on all pages (or all odd, even 

pages, or your customized pages), you can select the object and then click the Apply All button

, then define the apply page range in pop-up window like below: 

 
 

After adding links, flash, movie or sounds, you can click the icon  to save the settings and 

back to the template setting interface. 
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V. Language Options Interface 

Click "Option->Flash Language" or "…" button beside Language setting part, you will enter 

into the Language Settings interface as below shows: 

 

Panel Description: 

As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books 

in defined language, and the program provides you 10 different languages for you to use: 

English, Chinese, Arabic, French, German, Greek, Hebrew, Italian, Japanese and Portuguese.  

 

You can also add other language for your own uses: 

 

1. Click the button  and define name for the new language: 

 

 

2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box, 

then click "Save and Edit Next": 
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3. At last, you can get all Labels translated into your new language as the images shows: 

 

You can delete unwanted language:  

Or save your edited new language file as XML or TXT file:  

Load language file saving before for current using:  

 

 

After setting template and language, click  icon to 

apply the settings. 
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VI. Output Interface 

 

 

Output types: 

 

1. HTML 

 

This output type is for uploading created page-flipping ebook onto websites: 

 

You can define HTML Title and other properties by clicking "Advanced" button:  

 

  
 

Set Keywords, Description or even Script in the below interface: 
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2. ZIP 

 
 

This output type is for compressing the created files into an integral ZIP package which can 

be sending out as attachment directly. You can also define HTML Advanced Settings by 

clicking "Advanced" icon:  

 

Your recipients just need to uncompress the ZIP file and then they can view the HTML 

flipbook instantly: 

 

 

3. EXE 

 

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:  

 

You can also define Icon and Opening Window Size in Advanced Settings: 
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4. APP 

 

If you want to make executable application to run on Mac devices, you can output as 

"*.app" format. 

 

5. Mobile Version 

 

You can even output Mobile Version while choosing HTML or ZIP format at the same time. 

 

After creating mobile versions, you just need to output all files online (including HTML, SWF, 

"files" and "mobile" folders), then you can visit the flipbook page through your mobile 

browser.  

 

6. Burn to CD 

 

 

 

After choosing output type, then check the option "Burn to CD", set "CD Writer", define 

"Disc title". 

 

How to make created eBooks available for others online, more details this support page: 

http://flash-flipping-book.com/support/how-can-i-share-my-created-ebook-online.htm . 

 

At last click button to output flipbook in your defined type. 
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VII. Upload Online 

After designing your book style, you can click "Upload Online" button to 

upload your book onto Flash-Flipping-Book website server directly. Upload the books to 

Flash-flipping-book.com server, just need 4 steps: Register, Receive login username and password, 

login your account, upload your books. 

 

 

1. Register 

Click Register button in the program to build your account in Flash-Flipping-Book. Enter into 

http://panel.flash-flipping-book.com/chargeback/registered.php to create ID, as below interface 

shows: 

 

Input your Email, User Name (which will be a part of the final book online URL, like 

http://online.flash-flipping-book.com/Flash-Flipping-Book/demebook/index.html, 

"Flash-Flipping-Book" is your User Name, and "demobook" is the Book name.), read Terms of 

Service, if agree, then click "Subscribe" button to enter into PayPal interface, login and prepare to 
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pay for the service from the secondary month, because first month free, and you can stop the 

service at any time you want. 

2. Receive Login Username and Password 

Once you confirm and process the final payment on the PayPal web site, you will receive your 

Payment Receipt, Registration Information, Rental Information in your email box which you set 

while building your own account. And PayPal will charge your account periodically, and all of the 

paying info will be sent to your email box instantly. 

 

3. Login Account 

Back to PDF to Flash Flipping Book Pro program, then select "If you have an account", input 

your Email and Password to login.  

 

4. Upload Your Book 

After login your account, you will access into "Config the book" window to upload your just 

created book: 

 

 

You can set HTML metadata, like Title, Keywords, Description and Scripts. Check "Also Make 

Mobile Version" or not, set Book Name, which will be a part of the final book online URL, like 

http://online.flash-flipping-book.com/flippingbook/demebook/index.html, "PDF to flash 

flipping book" is your User Name, and "demo book" is the Book name. 

 

Click "OK" at last, your book will be published right away. You can use the Book URL to share 

with others online, or through social share websites, or copy the Embed Code to insert into 

web pages, etc. 
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More FAQs about Upload Service: http://panel.flash-flipping-book.com/userLoad/faq.php 

VIII. Batch Convert Interface 

 

1. Add PDF Documents 

Click this icon to add PDF files from computer; 

 Click this icon to add all PDF files in the folder (include sub-folders). 

 

You can also remove some unwanted PDF, move up/ down files, or clear all documents.  

 

 

2. Settings 

 

(1). Output Settings 

  i. Choose Output Type 

 

  ii. Choose Output Path 
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You can also define output name pattern with FileName, Title, Subject and so on: 

 

 

And after defining the File Name, you can preview the result example below: 

 

 

  iii. Define Output Option 

 

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon, 

Window Size for EXE flipbooks: 

 

 

 

  iv. Merge All PDF Files to One Flip Book 

 

(2). PDF Settings 

  i. Page Range 
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You can convert "All pages" or just "Custom range"; 

  ii. Watermark 

 

Click "Set Watermark" icon to enter into "Watermark" interface: 

 

Check "Applying Watermark" option, then you can choose default stamps, Edit them, or Add 

Text Watermark, Add Image Watermark, Delete, Move Down/ Up. 

  iii. Page Quality 

 

Choose quality and size type from listed five kinds. 

  iv. Other Options 

 

If your PDF file contains bookmarks, check this option to use in output 

page-flipping eBook; 
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If your PDF file has links, check this to enable in flipbook; 

Check this option to enable search functionality in created flipbook. 

 

At last, click  icon to batch convert listed files together. 

IX. Use PDF to Flash Flipping Book Pro in Command Line 

You can also use PDF to Flash Flipping Book Pro in Command Line. 

 

PDF to Flash Flipping Book Professional Command Line Usage: 

 

 PTCMD.exe [Options] 

 

 -f<PDF File>           The source PDF file. 

 

 -o<output folder>      Specify the folder for the output files. 

 

 -t[html|zip|exe]       Output type. Default is html. 

 

 -n<OutputFileName>   Specify the name for the output file. 

 

 -c<caption>           Caption for HTML or EXE. 

 

 -s<Flash settings>      Value format is:<Template name>#[<Theme name>| 

                     <txt_settingfile path>]. 

                     <Template name> could be: Classic, Float, Spread. 

                     <Theme name> are list in the "Select a template" window, 

                     such as Blank,Blues,Nostalgia. 

                     <txt_settingfile path> is the file that you export 

                     with "Save the template settings" function 

 

 -r<page range>.       The page range that you want to import from PDF File. 

                     Range value string like:2-15,33,35-36,or All.(Default: All) 

 

 -q<import quality>     Count be 5,4,3,2,1.5 specify the higher quality larger file 

                     size;1 specifies lower quality smaller file size.(default:4) 

 

-R<GS|SWF|LIB>       Render engine options. (Default: GS, Ghostscript render    
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engine)                                              

 

 -b<Y|N>             Import bookmark yes or no. (Default: Y) 

 

 -l<Y|N>              Import links yes or no. (Default: Y). 

 

 -S<Y|N>             Enable searchable or not.(Default: Y, enable searchable) 

 

 -k<html key words>    Set the keywords for html output file. 

 

 -d<html description>   Set the descriptions for html output file. 

 

 -j<html javascript>     Set the javascript for html output file. 

 

 -i<icon file path>      Specify the icon path for exe output. 

 

 -w<window size>      Specify the size of exe window. 

                     Value could be: M,F, or some string like:800,600. 

                     (width is 800,height is 600). 

 

 

 Examples 1: 

 PTCMD -f"C:\input.pdf" -o"C:\outputfolder" -n"index" -thtml -c"Title" 

-s"Float#c:\my_ebooksetting.txt" -r"1-8,9-14,42" -q4 -R"SWF" -bN 

 

 Examples 2: 

 PTCMD -f"C:\input.pdf" -o"C:\outputfolder" -n"ExeFileName" -texe -i"C:\app.ico" 

-c"Title" -s"Float#Blues" -r"All" -q5 -R"GS" 

 

 Examples 3: 

 PTCMD -f"C:\input.pdf" -o"C:\outputfolder" -n"index" -tzip -c"Title" 

-s"Float#Blank" -r"All" -q5 -R"GS" -k"html key words"\ 

 

 

Return Code: 

1:  Success 

2:  Input file not found 

3:  Parameters are invalid 

4:  Failed to load PDF 

5:  Failed to import bookmarks 

6:  Failed to import links 

7:  Failed to import searchable information 

8:  Failed to save the output file. 
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License Agreements   

 

All copyrights to PDF to Flash Flipping Book Pro (the Software) are exclusively owned by 

Flash-flipping-book.com. For more information, visit our website at 

www.flash-flipping-book.com . 

 

Anyone may use this software but all the page-flipping eBooks generated will automatically 

have a demo watermark on the first page of them. To remove the limitation you must 

register. 

 

Once registered, the user is granted a non-exclusive license to use the Software on one 

computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased, 

but may be permanently transferred, if the person receiving it agrees to terms of this 

license.  

 

The Software unregistered (trial) version may be freely distributed, provided the distribution 

package is not modified. No person or company may charge a fee for the distribution of the 

Software without written permission from the copyright holder.  

 

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR 

IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS, 

DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS 

SOFTWARE. 

 

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble, 

otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed 

Software, except as provided for in this agreement. Any such unauthorized use shall result in 

immediate and automatic termination of this license and may result in criminal and/or civil 

prosecution. 

 

All rights not expressly granted here are reserved by FLASH-FLIPPING-BOOK Solution. 
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Installing and using the Software signifies acceptance of these terms and conditions of the 

license. 

 

If you do not agree with the terms of this license you must remove the Software files from 

your storage devices and cease to use the product. 

  

 

How to Order 

 

Order Online (http://www.flash-flipping-book.com/pdf-to-flash-flipping-book-pro/index.html) 

or Order Toll Free 1-877-353-7297 (When you order toll free just give the operator the 

product number of the product you would like). 

 

How to purchase online?  

 

1. Select a license type above, and click [Buy Now] 

 

2. Select the currency that you want to use. (You can also continue shopping) 

 

3. Fill billing information and select a payment method. (Your information is safe with us) 

 

4. Check the information you filled previously and click "Place Secure Order"  

 

Other Order Ways—With Phone/Mail/Fax/Check: 

 

If you are not comfortable ordering online with a credit card, you are welcome to choose an 

offline order option in the payment section of the order process. We accept mail, fax, wire, 

and PO (if applicable) ordering options in addition to ordering online. We also provide 

phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for 

International Callers.  

 

Please note that all of the offline ordering options do have additional fees for processing. To 

place an order by mail, fax, wire, and PO (when applicable), use the online form and then 

choose one of these payment options found in the Payment Method section of the form. 

Once submitted online, the appropriate information will be provided to you in your web 

browser to send your payment to us offline. 

 

100% unconditional 30 Day Money Back Guarantee 
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Want to custom the program or have other questions about purchase? 

Contact us at support@flash-flipping-book.com . 

 

 

 

Support 

You can easily search or browse our frequently asked questions, and learn tutorials about 

products, and get your registration code back. If you are not satisfy with the solutions 

provided, please contact support team for help. 

 

1. Frequently Asked Questions 

You can find answers to questions about technique issues here: 

http://www.flash-flipping-book.com/support/list-pdf-to-flash-flipping-book-pro 

 

2. Learn tutorial about PDF to Flash Flipping Book Pro 

We publish a video tutorial which shows you the easy procedure of dealing with PDF to Flash 

Flipping Book Pro, you can view this video to quickly handle the stunning tool: 

http://www.flash-flipping-book.com/demo/pdf-to-flash-flipping-book-pro.swf 

 

3. Get lost license code 

Click here to look up the order » (http://www.regnow.com/cs/orderStatus) 

You can pull up a copy of your order by entering your email address. After you find your 

order, you may view its status, view details of your order (including the license key), and 

obtain the invoice.  

 

4. Contact Us  

If you have other questions or requirements, contact us directly through our support Email: 
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support@flash-flipping-book.com, we will respond you ASAP. 

 

 

 

 


